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Introduction
Multilingual Checks is a tool you can use to print the check amount in words, in
languages other than the system language. For example, a company in France may
want to print the check amount in words in Portuguese on the checks for its
vendors in Portugal. You can use Multilingual Checks to set up the currency
terminology for a currency ID, assign a default language for a checkbook, and select
and print checks in different languages. The different languages available are
Arabic, English, French, Portuguese and Spanish. You can also use Multilingual
Checks to print checks in the Canadian check layout specified by the Canadian
authorities.

Check for current instructions
This information was current as of Novemeber 2012. The documentation may be
updated as new information becomes available. Check the Microsoft Dynamics®
GP online Web site (http://go.microsoft.com/fwlink/?LinkID=249465) for the
most current documentation.
This introduction is divided into the following sections:
•
•
•
•

What’s in this manual
Symbols and conventions
Resources available from the Help menu
Send us your documentation comments

What’s in this manual
This manual is designed to give you an understanding of how to use the features of
Multilingual Checks, and how it integrates with the Microsoft Dynamics GP
system.
To make best use of Multilingual Checks, you should be familiar with systemwide
features described in the System User’s Guide, the System Setup Guide, and the
System Administrator’s Guide.
Some features described in the documentation are optional and can be purchased
through your Microsoft Dynamics GP partner.
To view information about the release of Microsoft Dynamics GP that you’re using
and which modules or features you are registered to use, choose Help >> About
Microsoft Dynamics GP.
The manual is divided into the following chapters:
•

Chapter 1, “Setup and Cards” provides information on how to enable
multilingual checks, set up currency terminologies, set up a default vendor
address language and set up a default language for a checkbook. You can also
select a format for the check layout, whether Default or Canadian, to print
checks.

•

Chapter 2, “Transactions” provides information on how to select and print the
payables checks batch, payables transactions and miscellaneous checks in
different languages.
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Symbols and conventions
For definitions of unfamiliar terms, see the glossary in the manual or refer to the
glossary in Help.
Symbol

Description
The light bulb symbol indicates helpful tips, shortcuts and
suggestions.
The warning symbol indicates situations you should be
especially aware of when completing tasks.
The multicurrency symbol points out features or procedures
that apply if you’re using Multicurrency Management.

This manual uses the following conventions to refer to sections, navigation and
other information.
Convention

Description

Creating a batch

Italicized type indicates the name of a section or procedure.

File >> Print or File >
Print

The (>>) or (>) symbol indicates a sequence of actions, such as
selecting items from a menu or toolbar, or pressing buttons in
a window. This example directs you to go to the File menu and
choose Print.

TAB

or ENTER

All capital letters indicate a key or a key sequence.

Resources available from the Help menu
The Microsoft Dynamics GP Help menu gives you access to user assistance
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays
the main “contents” topic. To browse a more detailed table of contents, click the
Contents tab above the Help navigation pane. Items in the contents topic and tab
are arranged by module. If the contents for the active component includes an
“Additional Help files” topic, click the links to view separate Help files that
describe additional components.
To find information in Help by using the index or full-text search, click the
appropriate tab above the navigation pane, and type the keyword to find.
To save the link to a topic in the Help, select a topic and then select the Favorites tab.
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the
Index tab active. To find information about a window that’s not currently displayed,
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics
and descriptions of the fields, buttons, and menus for the window, choose the
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appropriate link in the topic. You also can press F1 to display Help about the current
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window.
For example, if the Checkbook Maintenance window is open, you can choose this
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain
information before you can save the record and close the window. You can change
the font color and style used to highlight required fields. On the Microsoft
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance
resources. Access to some items requires registration for a paid support plan.
Current implementation and upgrade information The most recent
revisions of upgrade and implementation documentation, plus documentation
for service packs and payroll tax updates.
User documentation and resources The most recent user guides, howto articles, and white papers for users.
Developer documentation and resources The most recent
documentation and updated information for developers.
Product support information Information about the Microsoft Dynamics
GP product support plans and options that are available, along with
information about peer support and self-support resources.
Services information Information about Microsoft Dynamics GP support,
training, and consulting services.
Microsoft Dynamics GP Community Access to newsgroups, where you
can ask questions or share your expertise with other Microsoft Dynamics GP
users.
CustomerSource home page A wide range of resources available to
customers who are registered for a paid support plan. Includes access to
Knowledge Base articles, software downloads, self-support, and much more.
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Customer Feedback Options
Provides information about how you can join the Customer Experience
Improvement Program to improve the quality, reliability, and performance of
Microsoft® software and services.

Send us your documentation comments
We welcome comments regarding the usefulness of the Microsoft Dynamics GP
documentation. If you have specific suggestions or find any errors in this manual,
send your comments by e-mail to the following address: bizdoc@microsoft.com.
To send comments about specific topics from within Help, click the Documentation
Feedback link, which is located at the bottom of each Help topic.
Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use
them freely.
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Chapter 1:

Setup and Cards
Use the following information to enable multilingual checks, select the check, set up
the currency terminologies and select the default language for the checkbook and
vendor address.
You can now use Multilingual Checks to print checks in the new Canadian check layout
specified by the Canadian authorities.
When you set up Multilingual Checks, you can open each setup window and enter
information, or you can use the Setup Checklist window (Administration >> Setup
>> Setup Checklist) to guide you through the setup process. Refer to your System
Setup Guide (Help >> Contents >> select Setting up the System) for more
information about the Setup Checklist window.
This information is divided into the following sections:
•
•
•
•
•
•

Enabling Multilingual Checks
Enabling the Arabic language
Setting up currency terminology
Setting up the default checkbook language
Setting up the checkbook date format
Setting up the default vendor address language

Enabling Multilingual Checks
Use the ML Checks window to enable multilingual checks. Enabling multilingual
checks will allow you to print checks in multiple languages. You can also select a
format for the check layout.
You can start using multilingual checks only after enabling it in this window.

To enable Multilingual Checks:
1.

Open the ML Checks window.
(Administration >> Setup >> Company >> Company >> Options >>
Additional >> ML Checks)

2.

Mark the Enable Multilingual Checks option to enable the multilingual checks
feature. You must mark this option for each company for which you want to
print the checks in multiple languages.
If you unmark the Enable Multilingual Checks option, the multilingual checks
feature will not be available for the company the user has logged into. All the
multilingual checks setup information will be deleted.
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Select a check layout to print the check. This field is available only if you have
marked the Enable Multilingual Checks option.
Default Select this option to print checks in the default format defined in the
Microsoft Dynamics GP. You can specify a different date format and date
separator for each checkbook that you use with Multilingual Checks. Refer to
Setting up the checkbook date format on page 10 for more information.
Canadian Select this option to print checks in the format specified by the
Canadian legal authorities. The Language, Check Date Separators, and Check
Date Format fields become available.

4.

Select a language, whether English or French, to print the check. English and
French are the languages currently supported by the Canadian authorities for
Canadian layout checks.

5.

Select the character that will separate the day, month, and year in the Check
Date Separators field.

6.

Select the date format to be used for the check in the Check Date Format field.

7.

Choose Save to save the information you have set up.

8.

Choose OK to close the window.

Enabling the Arabic language
You must enable the Arabic language option for your system before you can print
checks in Arabic. Use the following information to enable the Arabic option for
different operating systems.

To enable the Arabic language for Microsoft Windows®
XP and Windows 2003:
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1.

Open the Regional and Language options window.
(Start >> Control Panel >> Regional and Language options)

2.

Choose the Languages tab.

3.

Mark the Install files for complex scripts and right-to-left languages (including
Thai) option in the Supplemental language support group. Click OK on the
message that appears and click the Apply button.

4.

Choose the Advanced tab and select the Arabic (U.A.E) option in the Language
for non-Unicode programs group.

5.

Choose Apply to apply the selection you have made.

6.

Choose OK to save the selection and close the window. A language bar appears
on your system taskbar, with the Arabic (U.A.E) option included.

7.

Mark the Arabic (U.A.E) option in the language bar to print checks in Arabic.
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To enable the Arabic language for Microsoft Windows
2000:
1.

Open the Regional options window.
(Start >> Settings >> Control Panel >> Regional options)

2.

Mark the Arabic option in the Language settings for the system scrolling
window.

3.

Choose Arabic (U.A.E) as the local language in the local (Location) list box.

4.

Choose the Advanced tab.

5.

Mark all the conversion tables for Arabic language in the Code Page conversion
Tables group.

6.

Choose OK and then choose Apply to apply the selection you’ve made.

7.

Restart your computer. A language bar appears on your system taskbar, with
the Arabic (U.A.E) option included.

8.

Mark the Arabic (U.A.E) option in the language bar to print checks in Arabic.

Setting up currency terminology
Use the information in this section to specify the appropriate currency unit, unitsubunit connector and currency subunit for a language specific to a currency ID.
You can set up the currency terminologies in different languages for each currency
ID. If you delete the currency ID, the currency terminologies specific to that
currency ID will be deleted.
If you are using the Canadian check layout, be sure to set up the currency
terminology here as per the legal specifications for the selected language. You must
enter the correct ISO Code for the selected currency in the Currency Setup window
to be printed on the checks.
If you haven't set up the currency terminology for a language, or if you have deleted the
currency terminology, the Amount in words field displays blank spaces while printing
checks.
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To set up currency terminology:
1.

Open the Currency Terminology Setup window.
(Administration >> Setup >> System >> Currency >> Additional >> Currency
Language)
(Administration >> Setup >> System >> Currency Language)

2.

If you have opened this window from the Additional menu, the Currency ID
will display default values from the Currency Setup window. Select a different
currency ID, if required.
If you have not opened this window using the Additional menu, enter or select
a currency ID.

3.

The Description field displays the description of the selected currency ID.

4.

Select the language for the currency ID, whether Arabic, English, French,
Portuguese or Spanish.

5.

Enter the currency unit that will appear on the printed checks for the selected
language and currency. For example, the currency unit for U.S. dollar when the
language selected is English would be “Dollars”.

6.

Enter the word that will connect the currency unit and currency subunit when
you print the checks. For example, the unit subunit connector for U.S. dollar
when the language is English would be “And”.

7.

Enter the currency subunit that will appear on the printed checks. For example,
the subunit currency for U.S. dollar when the language selected is English
would be “Cents”.
If you have selected the same language for the currency ID as the system
language, the Currency Unit, Unit-Subunit Connector and Currency Subunit
fields will display default values from the Currency Setup window. The
currency units for Arabic language will never be displayed as default values.

8.

Enter a text in the Local Termination field. This text will appear after the total
amount when you print the check.

9.

You can view an example of the terminology setup you have specified in the
Example field.

10. Choose Save to save the values entered in this window.
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11. Choose Delete to delete the currency terminologies set up for a language.

Setting up the default checkbook language
Use the Default Language Setup window to assign a default language to a
checkbook. The language selected in this window will be used as the default
language to print payables computer checks batches and miscellaneous checks
assigned to this checkbook. During transaction entry, you can change this language.
If you delete the checkbook ID set up in the Checkbook Maintenance window, all
the multilingual information set up for that checkbook will be deleted.

To set up the default checkbook language:
1.

Open the Default Language Setup window.
(Cards >> Financial >> Checkbook >> Additional >> Checkbook Language
Setup)

2.

The Checkbook ID and Description fields display the values selected in the
Checkbook Maintenance window.

3.

Mark the Multilingual option to assign a default language to the checkbook.
The Language field is available only when you mark this option.

4.

Select the default language for the checkbook. The options are Arabic, English,
French, Portuguese or Spanish. You can also select Vendor to print the check in
the default language selected for the vendor to whom you are making a
payment. Refer to Setting up the default vendor address language on page 11 for
more information.

5.

Select a check layout to print the check. This field is available only if the selected
language is either English or French.
Default Select this option to print checks in the default check format defined
in the Microsoft Dynamics GP. Refer to the Microsoft Dynamics GP
documentation for more information.
Canadian Select this option to print checks in the format specified by the
Canadian legal authorities. You can print Canadian checks only in English or
French languages.

6.

Choose the Check Date Format button to open the Checkbook Date Format
Setup window where you can set up the checkbook date format. This option is
available only if you have selected to use the default check layout for the
checkbook.
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Choose OK to assign the selected language to the checkbook and close the
window.

If you close the Checkbook Maintenance window, the Default Language Setup
window also closes, without saving the changes.

Setting up the checkbook date format
Use the Checkbook Date Format Setup window to specify a date format and date
separator for each checkbook that you use with Multilingual Checks. When you
print checks for a checkbook, the date format and the date separator will print
based on your selection in this window. The date format and date separator selected
for a checkbook remains constant, irrespective of the language in which the checks
are printed.

To set up the checkbook date format:
1.

Open the Checkbook Date Format Setup window.
(Cards >> Financial >> Checkbook >> Additional >> Checkbook Language
Setup >> select Default Layout >> Check Date Format button)

The Checkbook ID and the Description fields display the checkbook ID and its
description from the Checkbook Maintenance window.
2.

Select the date format for the checkbook in the Check Date Format field,
whether the default format or a custom format.
Default Format The date and the date separator formats used on the checks
for the selected checkbook are based on your system’s regional settings
(Start >> Control Panel >> Regional and Language Options >> Customize).
Custom Format The date and the date separator formats used on the checks
for the selected checkbook are based on your selection in this window.
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3.

Select the character to separate the date, month and year on checks in the Check
Date Separator field.

4.

Select the date format to use on the check in the Check Date Format field.

5.

Choose OK to save the check date and separator format for the selected
checkbook and close the window.
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Setting up the default vendor address language
Use the Vendor Address Language window to select a default language in which to
print checks for a selected vendor. You can set up a different language for each
address ID for a vendor.

To select a default vendor address language:
1.

Open the Vendor Address Language window.
(Cards >> Purchasing >> Vendor >> Address button >> select an address ID >>
Additional >> Vendor Address Language)
(Cards >> Purchasing >> Addresses >> select an address ID >> Additional >>
Vendor Address Language)

2.

The Address ID field displays the selected address ID from the Vendor Address
Maintenance window.

3.

Mark the Multilingual option to select a language. The Language field is
available only when you mark this option.

4.

Select a language, whether Arabic, English, French, Spanish or Portuguese, to
print the checks.

5.

Choose OK to save the changes.

If you close the Address Maintenance window while the Vendor Address Language
window is open, the Vendor Address Language window also closes, without saving
any changes.
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Chapter 2:

Transactions
Use the following information to select a language for a payables checks batch, for
payables transactions, and for miscellaneous checks.
This information is divided into the following sections:
•
•
•
•

Modifying the language for a payables check batch
Modifying the language for a single payables check
Modifying the language to print a miscellaneous check
Voiding and reprinting printed checks

Modifying the language for a payables check batch
The checks in a payables batch will print in the default language assigned to the
Remit to Address ID in the Payables Transaction Entry window. If no default
vendor address language is assigned, the check will print in the default language
for the selected checkbook ID. If no default checkbook language is assigned, the
checks will print in the language that you’ve chosen for your Microsoft Dynamics
GP installation. You can change this language in the Payables Batch Language
window if required. Refer to Setting up the default checkbook language on page 9 for
information on setting the default checkbook language.
If you have selected the Canadian check layout to print checks, we recommend that you do
not change the language to anything other than English or French.
This window will not open if you have marked the Enable European Electronic
Funds Transfer option in the Company Setup Options window (Administration >>
Setup >> Company >> Company >> Options) and selected Bank Transfer as the
payment method in the Payables Batch Entry window.
You can print checks in different languages for refund checks for sales if the Autoopen Print Payables Checks option is marked in the Refund Checks Setup window
(Administration >> Setup >> Sales >> Refund Checks).

To modify the language for a payables check batch:
1.

Open the Payables Batch Language window
(Transactions >> Purchasing >> Batches >> select a computer checks batch >>
Additional >> Payables Batch Language);
(Transactions >> Purchasing >> Print Checks >> select a computer checks
batch >> Additional >> Payables Batch Language);
(Transactions >> Purchasing >> Select Checks >> Print Checks >>
Additional >> Payables Batch Language);
(Transactions >> Purchasing >> Edit Checks >> Print Checks >> select a
computer checks batch >> Additional >> Payables Batch Language);
(Transactions >> Sales >> Refund Checks >> Select Checks Batch ID zoom >>
Additional >> Payables Batch Language)
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2.

The Batch ID field displays the batch ID for which to print checks.

3.

Mark the Multilingual option to select a language. The Language field becomes
available.
The Multilingual option is marked, and the language field displays the default
language selected for the checkbook ID. The Multilingual option is unmarked
and the Language field unavailable if no default language has been selected for
the checkbook ID.
If you unmark the Multilingual option, the Multilingual Checks feature will be
unavailable for the batch. The checks will be printed in the language that you
have chosen for your Microsoft Dynamics GP Installation.

4.

Select the language to print the check batch. The options are Arabic, English,
French, Portuguese, Spanish or Vendor.
Vendor The checks for each vendor will print in the language assigned to the
address ID selected in the Remit To field in the Vendor Maintenance window. A
vendor may have no Remit To address ID assigned, or no language assigned to
the Remit To address ID. The checks for such vendors will print in the language
you’ve chosen for your Microsoft Dynamics GP installation.
To print the checks in Arabic, be sure to choose the Arabic (U.A.E.) option from the
language bar in your system task bar before printing the checks. Refer to Enabling the
Arabic language on page 6 for more information.

5.

Choose OK to save the changes and close the window.

6.

Choose Print in the Payables Batch Entry window to print the checks in the
selected language. The checks will be printed in the layout that you have
selected for the checkbook ID. You cannot change the language for a check once
you’ve printed it. You can select any of the nine formats for printing the checks
in different languages. Refer to the Microsoft Dynamics GP documentation for
more information on check printing formats.

If you close the Payables Batch Entry window or the Print Payables Checks window,
the Payables Batch Language window also closes, without saving the changes.

Modifying the language for a single payables check
The check for a payables transaction will print in the default language assigned to
the Remit To address ID in the Payables Transaction Entry window. If no default
vendor address language is assigned, the check will print in the default language
for the selected checkbook ID. If no default checkbook language is assigned, the
checks will print in the language that you’ve chosen for your Microsoft Dynamics
GP installation. You can change this language in the Payables Transaction Language
window before printing the check. Refer to Setting up the default vendor address
language on page 11, and to Setting up the default checkbook language on page 9 for
more information.
If you have selected the Canadian layout to print checks, we recommend that you do not
change the language to anything other than English or French.
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To modify the language for a single payables check:
1.

Open the Payables Transaction Language window.
(Transactions >> Purchasing >> Transaction Entry >> Click Check expansion
button >> Additional >> Payables Transaction Language)

2.

The Check Number field displays the check number from the Payables
Transaction Entry window.

3.

Mark the Multilingual option to select a language. The Language field becomes
available.
The Multilingual option is marked, and the language field displays the default
language assigned to the Remit To address ID, or to the checkbook ID, in that
order. The Multilingual option is unmarked and the Language field unavailable
if no default language has been selected.
If you unmark the Multilingual option, the Multilingual Checks feature will be
unavailable for the transaction. The checks will be printed in the language that
you have chosen for your Microsoft Dynamics GP Installation.

4.

Select the language to print the check. The options are Arabic, English, French,
Portuguese, Spanish or Vendor.
If you select Vendor, be sure to select an address ID in the Remit-To field that
has a language assigned to it. If you don’t, a message is displayed indicating
that no language has been selected. You can select a language in this window to
print the check or assign a language to the Remit-To address ID in the Vendor
Address Language window.
To print the checks in Arabic, be sure to choose the Arabic (U.A.E.) option from the
language bar in your system task bar before printing the checks. Refer to Enabling the
Arabic language on page 6 for more information.

5.

Choose OK to save the changes and close the window.

6.

Choose Print in the Payables Transaction Entry window to print the checks in
the selected language. The checks will be printed in the layout that you have
selected for the checkbook ID. You cannot change the language for a check once
you’ve printed it. You can select any of the nine formats for printing the checks
in different languages. Refer to Microsoft Dynamics GP documentation for
more information on check printing formats.

If you close the Payables Transaction Entry window, the Payables Transaction
Language window also closes, without saving the changes.
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Modifying the language to print a miscellaneous check
Miscellaneous checks will be printed in the default language assigned to the
checkbook ID for the check. If no default language is assigned, the check will print
in the language that you’ve chosen for your Microsoft Dynamics GP installation.
You can change this language in the Miscellaneous Check Language window before
printing the check. Refer to Setting up the default checkbook language on page 9 for
more information on setting the default checkbook language.
If you have selected the Canadian layout to print checks, we recommend that you
do not change the language to anything other than English or French.
If you’ve selected Vendor as the default checkbook ID language, you can select a different
language in the Miscellaneous Check Language window. If you do not select a language, the
check will print in the language that you have chosen for your Microsoft Dynamics GP
installation.

To modify the language to print a miscellaneous check:
1.

Open the Miscellaneous Check Language window.
(Transactions >> Financial >> Miscellaneous Check >> Additional >>
Miscellaneous Check Language)

2.

The Check Number field displays the check number from the Miscellaneous
Check Entry window.
The Multilingual option is marked, and the language field displays the default
language selected for the checkbook ID. The Multilingual option is unmarked
and the Language field unavailable if no default language has been selected.
If you unmark the Multilingual option, the Multilingual Checks feature
becomes unavailable. The checks will be printed in the language that you have
chosen for your Microsoft Dynamics GP installation.
Mark the Multilingual option to select a language. The Language field becomes
available.

3.

Select the language to print the check. The options are Arabic, English, French,
Portuguese, or Spanish.
To print the checks in Arabic, be sure to choose the Arabic (U.A.E) option from the
language bar in your system task bar before printing the checks. Refer to Enabling the
Arabic language on page 6 for more information.

4.
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Choose Print Check in the Miscellaneous Checks window to print the checks in
the selected language. The checks will be printed in the layout that you have
selected for the checkbook ID. You cannot change the language for a check once
you’ve printed it.

If you close the Miscellaneous Checks window while the Miscellaneous Check
Language window is open, the Miscellaneous Check Language window also closes
without saving any changes.

Voiding and reprinting printed checks
You can reprint a check with the same options once it is printed, using the following
procedures. You can reprint a check in different formats. Refer to Microsoft
Dynamics GP documentation for more information on check printing formats.
To print the checks in Arabic, be sure to choose the Arabic (U.A.E.) option from the language
bar in your system task bar before printing the check. Refer to Enabling the Arabic language
on page 6 for more information.

To reprint a check from the Payables Transaction Entry
window:
You can reprint checks with a different check number even if you’ve deleted the
currency terminologies for the language or unmarked the Enable Multilingual
option in the ML Checks window. To reprint checks in the Canadian check layout,
you must have marked the Enable Multilingual option in the ML Checks window.
To reprint a check in another language, you must post, void and reenter the
transaction for the check in the Payables Transaction Entry window.

To void and reprint a check from the Print Payables
Checks window:
You can reprint checks with a different check number even if you’ve deleted the
currency terminologies for the language or unmarked the Enable Multilingual
option in the ML Checks window. To reprint checks in the Canadian check layout,
you must have marked the Enable Multilingual option in the ML Checks window.
To reprint a posted check in another language, you must void the transaction in
Microsoft Dynamics GP, build the batch, select a different language and then print
the checks.
To reprint an unposted check in another language, void the printed check, and
create and build a new batch in the Select Payables Checks window.
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Glossary
Canadian
New Canadian check layout.

Checkbook ID
The alphanumeric sequence used to identify
a checkbook. These ID’s have to be unique.

Currency
Any form of money, including bills and
coins, used as a medium of exchange in a
country.

Currency ID
The alphanumeric sequence used to identify
a currency. These ID’s have to be unique. For
example, the currency ID for U.S. dollars can
be Z-US$.

Currency subunit
The secondary denomination of a country’s
medium of exchange. For example, the
currency subunit for U.S. dollar would be
“Cents”.

Currency terminology
The terms used to print the currency units,
subunits and the unit-subunit connector in
words.

Currency unit
The primary denomination of a country’s
medium of exchange. For example, the
currency subunit for U.S. dollar would be
“Dollar”.

Multilingual
Printing check amounts in words in different
languages.

Payables Checks batch
A payables check batch has all the payables
payment transactions with the payment
method as check and they can be saved,
printed or posted directly.

Payables computer checks
Checks that are auto calculated and printed
using the accounting system.

Separator
The symbol used to separate the date, month
and year.

Unit-Subunit connector
The word that will connect the currency unit
and subunit when a check is printed. For
example, the unit subunit connector for U.S.
dollar would be “And”.

Void printed checks
The process of reversing the effect of a
printed computer check.
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Index
A
Arabic language, enabling 6

C
changes since last release, information
about 3
checkbook date format, setting up 10
Checkbook Date Format Setup window,
displaying 10
currency subunit for a currency, setting up
8
Currency Terminology Setup window,
displaying 7
currency terminology, setting up 7
currency unit for a currency, setting up 8
current upgrade information, accessing on
the Web 3

D
default checkbook language, setting up 9
Default Language Setup window,
displaying 9
documentation, symbols and conventions
2

P
Payables Batch Language window
described 13
displaying 13
Payables Transaction Language window
described 14
displaying 15
printed checks
reprinting 17
voiding 17

R
reprinting
checks from the Payables Transaction
Entry window 17
checks from the Print Payables
Checks window 17
required fields, described 3
resources, documentation 2

S
symbols, used in manual 2

T
tutorial, accessing 3

U

help, displaying 2
Help menu, described 2

unit subunit connector for a currency,
setting up 8
upgrade information, accessing on the
Web 3

I

V

icons, used in manual 2

vendor address language, setting up 11
Vendor Address Language window,
displaying 11
voiding, checks from the Print Payables
Checks window 17

H

L
language for a payables transaction entry
printing 14
selecting 14
language for payables checks batch
printing 13
selecting 13
lessons, accessing 3
lookup window, displaying 3

W
what’s new, accessing 3

M
Miscellaneous Check language,
modifying 16
Miscellaneous Check Language window,
displaying 16
ML Checks window, displaying 5
Multilingual Checks, Setup Checklist 5
Multilingual Checks, enabling 5

N
navigation, symbols used for 2
new features, information about 3

O
Orientation training, accessing 3
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